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*����/��Locations of the GMRT antennas

Why meter wavelengths :���
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*����7� A GMRT antenna
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2. PERMANENT MAGNET DC SERVO MOTORS

*��/����A permanent magnet DC servo motor
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*��/�/��Magnetic field lines between north and south pole
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*��/�7��Current produced in magnets
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3. DC SERVO MECHANISM
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4. THE GMRT SERVO SYSTEM
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*��:�/'��Specifications of GMRT servo system

*��:�7���Principle of position control
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*��:�7'��Principle of position control

*��:�:��GMRT servo control block diagram
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5. THYRISTOR BASED POWER CONTROL
�5E+� �4+���+,.4,�?.
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*��<�7��Single phase half wave SCR rectifier waveforms
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*��<�>� Voltage and current waveforms
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*��<��8��Six pulse converter waveforms
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*��<�����Waveform of the load voltage for a six pulse converter
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6. SERVO AMPLIFIER
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7. EQUIPMENT DESCRIPTION
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8. SERVO SYSTEM OPERATION
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9. MODE SELECTION
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10. PCB DESIGN USING SOFTWARE
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*���8����Motor Control Card circuit (schematic) diagram
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*���8�/��Interlock and Brake Card circuit (schematic) diagram
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*���8�7��Creating a new schematic sheet

��
����
�'���1��	�
����	���

���$
���0
�����	
��������
�0��1�$�	
�	����
�����
����������'�����	���
����

����
�����
0�'���������
0������'������
�!���'�
����
��
���'�����	���
���
0���
���������
�Sheet $��
�����

���$��

����
���
���0������
� 	�
����	�(�������

�33�,&� -5(#���-� 5((� ��4����+4K(-��?. 

�����
��	�
����	���

���0
�0����������������$��"
	�����
���!
�'

���$
�
�����*�

�3�	��
�����0
������.

	��	1������
�$��"
	�����
������
����"
	���$��
�������
�
	� �Add Existing to Project���
�	����
���
���

�

��	��
��� ����
��� �����	��	1 �Open� ����
�����!
�
� �0
�	�� �����.���.���$� ��
 � ��

 ���	��
�� � ���� � ��
�

$��"
	����	��
��������������
����"
	���$��
�����
��	�
����	���

�������0�����
�����
�� ���	
�3�	��
����

'
�
������
�$��"
	�����
������
����"
	�����'�����������1
�������
�$��"
	�����
��

@�



Drive Electronics for GMRT Servo System

64-���,&��5(�-4#�4,(,� ��,3�64�3�,&��5(�6��+�+�( �?.

��������
���
���������������	�
����	��
�'���� ��	���
��0�����������3
����
�� ���
� 	�
����	�(������

$��!��
��$�0
�������'���
��
��	���
����
��������������
�	��$��
����0
��
9���
���
������
��
�������������
��

��'����
�����������
�������1��0���0�����
��	������������
���'����
����������	��$��
����

����
�	��	1������
�Libraries ��'�������$��
���
�Libraries $��
���

/���
�$�
�����
 �Search '�����������
 �Libraries  $��
�������
�
	� �Tools » Find Component������$
����
�

Libraries Search ��������

7���
�
����
����� �Search in  ���$���0�������
 �Options  �
���������
���� �Components  ���������
2��$�
��

��
�
���
����
���$������������'���
��
��	���������������
�
���	���
����

*���8�:��Libraries search

:���
�
����
��������
�Scope ����
�����Libraries on Path �����������
�Path ��
���	����������
�	���
	���$����

���������'����
������0
��		
$�
����
��
���������
	����
�������������������������
�$�����������'
�-?v��������

*��
�v�������3
����
��@v6�'���
v���
�	��	1������
�����
���	������'��0�
������
���'���
�����
���(����
������

@/



Drive Electronics for GMRT Servo System

��
�Include Sub directories '�2���������
�
	�
���������	1
������������
2��$�


�
�0��� � �� ��
��	����� ���� ��
�
�
�	
� ��� �7;8:� �����
$
 �S7;8:S ������
�9�
�
��
	������� � ��
� ��$��� � ��
�

Libraries Search ����������
�S��
�'��������0����	������
�������1
�������		�������
�����
�
���$�
��2
������

�����2
����
��'
�����
�
���������	���
����

@���
�	��	1���
�Search '���������'
������
��
��	�����
�N�
�
�+
��������
����$��

�������
�Libraries $��
��

�����
��
��	����1
��$��	
��

=� �
�	��	1������
�	��$��
������
 �/,7;8: ������������
 �#��	
����
����3
!�	
�����6�' ���'���
����

�
�
	�������������'���
������
�'��������������
��!����'�
�����������.�
��
��K��������������

@7



Drive Electronics for GMRT Servo System

*���8�<��Searching for components

>� >�����0
�	����
���	��$��
���������
���
���������'���
������0�������	���
���
��������
���0
�0�����'
 �

@:



Drive Electronics for GMRT Servo System

��1
�����	���������
������������������������'���
�'
���
�0
�	�����$��	
���
�	��$��
�����������	�
����	��

 ��	
���
�#��	
����
����3
!�	
����'���
�0
��

��������
��
��������
��'
��
���������
�	��$��
�������
��
����

$��	
�

��
����
����'����
��0�����$$
��������
����$���0������������
���$������
�6�'����
��$��
������0
�	��	1������

��'���
����
������
��$$
����������
�	��$��
�����'���
���
�����
��'
��0����
�	��$��
�������
�������
�$��
��

	�����
��'
���
�����9��	1�
���	��
���	��$��
���0����������'���
��

�6�-�,&��5(�-4#�4,(,� �4,�4�+� -5(#���-�?.
�� ��
��
�
	� �View » Fit  Document  U�����	��? �V� �DV � �� �
����
������	�
����	 ���

� � ��1
���$� ��
������

0����0��

/���
���1
����
���
�Libraries $��
��������$��

��'
�	��	1���������
�Libraries ��'��

7��N������N/���
��K������������������0
��
�
	����
�#��	
����
����3
!�	
�����6�'���'���
��������
�6�'����
��

���$.��0������������
���$������
�6�'����
��$��
�������1
������
��	��!
���'���
��

:� ��
���
� ��
�����
� � �� �9��	1�
���	��
 � ��
�	��$��
�� �0
��

�� ���
��
����� �0���.	�����S� �0��� � ���� �����

	��$��
���������������
���'���
���
��
����
�����
��'
��
$����S7;8:S������
�����
����
���'
��0���
�6�'���
�

���
������������	��$��
����0��	����!
���
��
2��D7;8:F����$���������
���-��$��
���,��
���
���0����'
 �

���$��

��

<������
�Properties �
	����������
���������0
��
����
�!���
�������
�������	��$��
����
���������'
��
$����N��

�����
�Designator ��
���

@��,
2��0
�0����	�
	1���
�����$����������0����'
���
������
$�
�
�����
�	��$��
��������
��-���

��
 � ���1 �'
�0

� � ��
 � �	�
����	 � 	��$��
�� � ��� � ��
 ��-��	��$��
�� � �� � ��
 � ����$����� ���
 � ����$�����

�$
	���
�������
��	�
����	��������
���������
��-����'���
�0�
��0
��������
��
��������
����'�
.	��	1������

�	�
����	�	��$��
�������$
	��
���
�����$������

����������������

@<



Drive Electronics for GMRT Servo System

*���8�@��Editing the component properties

�
���
���0��
��
����$��	
���
�$�����

����
���!
���
�	�������0������
�������������
�'�������	�
������$����������
����������������
9���
�������
�

��

�� �4�	
�0
���
 ���$$
�0���� ��
 � ����������C� �$�������� �0
� �
��.	��	1 ��� �$�
�� �ENTER  �� �$��	
 � ��
�

@@



Drive Electronics for GMRT Servo System

������������������
��	�
����	�

/���
���!
���
�	����������0
�0����������������	�$
������
����������������'

��$��	
�������
��	�
����	�

��

���'���0
���
����������$����$��	
�
������
�0������
�$����������
���������������
�	�������������
����
����

�������3
����
������0��������$��	
������$�
�$����������
����
��
$
�� ����0�0
�$��	
���
��
	����������������

���������������������
����
������
�$�
!�������
�������
�
��������

�����
�������������'��
��'
���
�0
�$��	
�����

�������3
����
��0������������	���
���	�
�
�����	��$��
��C���
���������0�
��0
�$��	
����
��
�����$������

��������	��
����
��
2�������������0
�$��	
�0������������	���
�'
��
������
��N/��

��
��0
���
������
�
����������$��	
�
������
����	����������	����������	��!
�����!������
�	�����������
�


��
������
���	��
���0����0�0������������	���
�$������
���	��
����

���0
��		��
�����
�$������������0���
�0
���
�0�������$�����	��	�����$�
������*����
0�w�*�������4'"
	������ �

�
���0���
��	�
����	�0����0�����0��������$��	
���'"
	���������	���'
����
�
!
��0�
��0
���
������
�

�����
����$��	��������'"
	���

�
���
���
������0����1

���������$����
���
�$������������������
�	�����?�

.�E����$����
�$����!
���	���
�

.�L����$����
�$��������B������
�

������������.� $�	
�'��������
����
�$����'
�;8x�����.	��	10��
�

 ��	
�0
���!
���0�$��	
����� ���
��������������0
�0����
2���$��� �$��	
�
������
�'
�	��	1������
�������

����
�'���������$�
������( -�1

����
�	������0�����
!
���'�	1�������������������0��

�� � 
��� � ��
 � �����'��
� � �� � �� ��'"
	� � $��	
� ��� � ��
 � �	�
����	� �0
 ����'�
.	��	1 � ��
 ��'"
	� � �� � �$
� � ����

Component Properties ��������

��+�,&�����5(�-�+-����?.

• ������������
�$��	
������	�
������	���
	��!��
�'
�0

����
�!�������	��$��
�����������	��	�����

• ������$��	���
�
������
����$
������0��
�������
����
�����$��	����'"
	����	
��������'

��$��	
���0
�

$����������
�����0�	�������!
���������	��	1���	
��

@=



Drive Electronics for GMRT Servo System

• ��
�
!
����0��
�������	�������
�	���
	�����$����������	��$��
�����������
������
����������
��

0��
���������3
����
��0������������	���
�	�
��
���"��	������

• ��
��$��	����0��
���0
���!
����1

$�����������
������0����$�����?�

.��
��
��.	��	1����$�
���(,�(+������	������
�0��
������
�	������$�������u�

.��
�$�
�����-% ��-(�����
��!
���
��������	����$����u�

. ����
� � $��	��� � ��
 � ���� � �
��
�� ��� � � �0��
� �0
 � �����.	��	1 ��� �$�
�� �( -� �� �
�� � ��
 �0��
�

$��	
�
������
�	������0�����
����������	��������������0
�	���'
����$��	���������
��0��
��

• �
������.	��	1����������$�
���( -����
2���0��
�$��	
�
������
�

�������3
����
� ���� � � �������
!
� ������ � ����0��� ��� � �� � ���� � ��
����'
� ��� � $�
!���� � �	������ ���
�

��2��������'
������������
$�������
�.	��������'�
����������
�����
�'
���
��!����'�
��
���
��������

	��$��
���

-5(-%�,&��5(�(6(-�+�-�6��+4�(+��( �4*�4�+� -5(#���-�?.

 	�
����	���������� ����������3
����
� ���
 ����
������"��� ����$�
����0�����)� ��

�	�������
�
	���	���

	���
	��!��
��������������'������
�	��	������
�	�����
������	���
	��!��
��0��
�
������!
���
������
������

��
��0
�	��$��
���$��"
	����������3
����
��	�
	1������
�������		������������
����
���
���$������
�Error 

Reporting ����Connection Matrix ��'��������
�!�����������
�
���
��0�������$��
������
��
����
�$��
��

-4#��6�,&��5(��+4K(-��?.

-��$��������$��"
	��	�
	1�������������������
�
	���	������
��
�����������
��
�������	��
��������$������������

���
'�������
�!�����
�����
���!
����
��
��
���$���
����
�������
�Error Checking ����Connection 

Matrix ��'�������
�Options for Project ��������

������	��$��
���$��"
	����
�
	��Project » Compile PCB Project��

/����
����
�$��"
	�����	��$��
�����
�
�������
�
���
��0�������$��
������
�Messages $��
���-��	1���������

@>



Drive Electronics for GMRT Servo System

$��
�����	�
	1�����
�������View » Workspace Panels » System » Messages�����
�	��$��
����	��
����

0����'
�����
�������
�Navigator $��
������
��
��0�����������
�
����
���	�
��	��$��
���������
�������
��������

	���
	��������
�������	���'
�'��0�
���

�������	��	����������0��	���
	��
����
 �Messages  $��
�������������	���������
�
������������
��
$������!
��


�������	�
	1�����	��	��������
����
�����0����������	���
	��������
�	���
	���

��
�Messages $��
��0�������$��
�0��������
����
������	������0
���!
���	���
	�
��$�����������	��	�����

 
�
	��View » Workspace Panels » System » Messages �����
�Messages $��
������������$��

���

7���
����'�
.	��	1�������
��������0������������
 �Messages  $��
��������
 �Compile Errors  0����0�0����

���$��
�0�����
�����������
�!����������*���������0����0��0
�	���	��	1�������
���������"��$������
�!�������� �

�'"
	��������	�
����	����	�
	1����	���
	����
�
�����

-+(���,&���,(���-��34-�#(,��?.

�
���
�0
�������
����
��
������������
 Schematic Editor �����
 PCB Editor, we��

�����	�
��
���
�'���1�

�-��0��������
������'�����������
� ��
�
���
���0�
����	�
��
����
0��-���
������� �������3
����
��������

��
���
 PCB Board Wizard��0��	������0��������	����
�������������
.���������'�����������
�����0
������

	�
��
������0��	������'�������B
��������
�����
�0
�	�����
���
�Back '���������	�
	1���������
�$�
!�����

$��
�������
�0�B�����

���	�
��
����
0��-����������
��-����B�����0
�	��$�
�
���
������0������
$�?�

����
�	�
��
����
0��-��'
�	��	1�������PCB Board Wizard �����
�New from Template �
	����������
�

'�����������
 �Files  $��
������������$���������������$��

�������
��	�

���0
�	���
����
������
��
	������

�'�!
�'
�	��	1���������
��$�����0��	�����

/����
 �PCB Board Wizard  �$
������
��������	�

��0
��

������
��������	�����$��
���
�	��	1���
 �Next 

'���������	������
��

7���
��
����
��
����
����������#
���	����0
���
�������
�
��

@;



Drive Electronics for GMRT Servo System

*���8�=��Creating a new PCB document

:����
�������$��
������
�0�B��������0���������
�
	����
�'�����������
�0
�0���������
���
�0����
��
�������0��

'�������B
���
��
�
	��Custom �������
���������'�����������
������	��	1�Next��

<�������
��
2��$��
�0
�
��
��	������'������$�������*�������	��	�������'�����������
��������7/���2��8>�

������	������B
��� 
�
	��Rectangular � �
$
��7/������ �Width �����8>���Height ��
������
��
�
�
	��

Title Block & Scale��Legend String ����Dimension Lines���
�	��	1�Next ���	������
��

@�������$��
�����0���������
�
	����
����'
�������

��������
�'�������
�0�����

���0�����������

����������

$�0
��$���
����
�	��	1�Next ���	������
��

=���
�	����
���
�!�����
�
����
�������
��
�����'
��
�
	�������������
 Vias only ����	��	1�Next��

=8



Drive Electronics for GMRT Servo System

>� ���
 ��
2� � $��
 � ����0� ��� � �� � �
� � ��
 � 	��$��
��H���	1 � �
	������
 � ��������� � �$������ ��
 � �
�
	� � ��
�

Through-hole components  �$����������
����
����'
��������	1��'
�0

����"�	
���$������ �One Track��

-��	1�Next��

;����
��
2��$��
�����0���������
���$����
������
��
��������
���������	1�0���������!�����B
��������$$�
������� �

'�������
��
�!
���
��$���������������	�

���
�������
����
���������
�	��	1�Next��

�8���
�	��	1 �Finish����
 �PCB Board Wizard  ������0�	���
	�
��������
�����������������

������	�
��
�


�����
0�'��������
��-��(������0������0����$��
����
0��-�����
����
���-����	'3�	��

������
��-����	��
������$��
��0�������
��������B
��0���
���

��������'���1�'��������$
��'��	1���
��0����

�����������������������0
��
�
	��Design » Board Options �����
�
�
	��Display Sheet �����
�Board Options  

�������

*���8�>��PCB board before placing the components

=�



Drive Electronics for GMRT Servo System

�33�,&���,(���-���4����+4K(-��?.

�����
��-��0
�0����������������$��"
	�����
�����'

���$
�
�������*�

�3�	��
����0
������.	��	1������
 �

�-��$��"
	�����
������
�Projects $��
�������
�
	��Add Existing to Project���
�	����
���
��
0��-�����
�

���
�����	��	1��� �Open����
��-�������0�����
�����
� �Source Documents  '
�
������
�$��"
	�������
�

Projects  $��
������������1
�������
�$��"
	�����
���
�	����������������'
������������
���

���	��
�������

���$$�������������$��"
	�����
���
���!
���
�$��"
	�����
��

�+�, *(++�,&��5(�3( �&,�?.

�
���
�������
��������
��	�
����	������������������
��
0�'���1��-���0
���1
����
�������
��
���
����'����
��

����'�����	�
����	������-����
��!����'�
�� ��	
����
���
��
�������������
�����
����
����'����
����
���
�����

�����������������
�����$������0�������
��
�'
���	���
���4�	
���
�$��"
	������'

��	��$��
��������
�
���������

��
��	�
����	���2
���0
���
���
�Update PCB 	�����������
�
���
�(-4�������0����������
����
��	�
����	�

�����������������
�����
���-���

Updating the PCB :-

����
�����
��	�
����	������������������
�����
���-���������$��"
	�?�

����
��$
����
��	�
����	���	��
���

/���
��
�
	��Design » Update PCB Document ����
�$��"
	��	��$��
��������
�Engineering Change Order 

����������$��
��

7���
�	��	1����Validate Changes���������	����
����
�!������
�����
���

����	1���$$
��������
� ���������������

��
�	����
����
�����!������
���	���
���
���������0
�	�
	1���
�Messages $��
������	�
�����
�
�������

:���
�	��	1��� �Execute Changes  ����
�����
�	����
�������
��-�����
��	��$�
�
�����
 �Done 	������


����
��'
	��
���	1
���

<���
�	��	1�Close ������
�����
���-���$
���0����	��$��
����$�������
���
��
�����$��	���������
�'������

�
���
���
������	���V��D �View » Document�����0
�	�������

���
�	��$��
�����������	���
���!�
0�

=/



Drive Electronics for GMRT Servo System

*���8�;��Change order

*���8��8��Components before being placed on the board
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*���8��7��A manually routed board

Tips for Placing Tracks :-
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*���8��:��An automatically routed board
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*���8��<��Gerber setup
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*���8��@��Motor Control Card PCB layout
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*���8��=��Interlock and Brake Card PCB layout
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11. FUTURE SCOPE
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	The Giant Metrewave Radio Telescope, an aperture synthesis array consisting of 30 fully steerable parabolic dishes of 45 metre diameter each. Motion of these giant antennas need to be controlled by a precession control system. Pointing of the antennas should be accurate i.e. the radio source, antenna focused and the antenna center should be aligned. The GMRT servo system has designed with three nested control loops to achieve the pointing accuracy of (1 or 2) arc minutes RMS for wind speed less than 20 kmph. Because of high weight alt-azimuth mount is most favourable approach for positioning the dish antenna. Here the elevation axis sits on the azimuth drive. The elevation drive moves antenna up and down directions while azimuth drive moves antenna in clockwise & counter-clockwise direction. Hence enabling the antenna to point anywhere in the sky. 

